The OSIRIS User Guide

3rd Edition

M.T.F.Telling and K.H.Andersen

ISIS Facility
Rutherford Appleton Laboratory
Chilton
Didcot
OX11 0QX

February 2008
This user guide contains all the information necessary to perform a successful neutron scattering experiment on the OSIRIS spectrometer at ISIS, RAL, UK. Since OSIRIS is a continually evolving and improving instrument some information contained within this manual may become redundant. However, the basic instrument operating procedures should remain essentially unchanged. While updated manuals will be produced when appropriate, the most comprehensive source of information concerning OSIRIS is the Instrument Scientist /Local Contact. It would be appreciated, however, if this user guide were the first point of call should problems arise.
ACKNOWLEDGEMENTS

It is a pleasure to acknowledge all those who have contributed to the production of this user guide. In particular, past and present members of the Molecular Spectroscopy Group at the ISIS facility, UK, for fruitful discussion and comments.
## CONTENTS

1. Introduction
   
   1.1 The Instrument
   
   1.2 Principle of Operation
      
      1.2.1 Quasi / in-elastic neutron scattering
      
      1.2.2 Diffraction

2. Performing an experiment on OSIRIS
   
   2.1 Before arriving on OSIRIS
      
      2.1.1 The User Office, film badges and swipe cards
      
      2.1.2 Sample safety assessment

   2.2 Selecting sample cans and scattering geometry
      
      2.2.1 Flat plate cans for QENS/INS experiments
      
      2.2.2 Cylindrical cans for QENS/INS experiments
      
      2.2.3 Sample cans for diffraction experiments

   2.3 Loading a sample into the neutron beam

   2.4 The beam line shutter interlock system

   2.5 OSIRIS computing overview

   2.6 Suitable instrument settings

   2.7 Data collection
      
      2.7.1 CHANGE
      
      2.7.2 BEGIN
2.7.3. Inspecting data 18
2.7.4. END and end of an experiment 19

3. OSIRIS Computing 20

3.1. Instrument Control 20

3.1.1. The Data Acquisition Electronics 20
3.1.2. Instrument Control 21
3.1.3. The Dashboard 22
3.1.4. S.E.C.I and Eurotherm 22
3.1.5. Temperature control 23
3.1.6. Command files 24

3.2. Data Visualisation and analysis 25

3.2.1. Data Analysis and Reduction Software 25

4. References 28

Appendix I QENS / INS Settings 29
Appendix II Diffraction Settings 30
Appendix III Instrument Parameters 34
Appendix IV P.I.D parameters 37
Appendix V Out of hours support 38
Appendix VI Useful telephone numbers 39
Appendix VII Useful diagrams 40
Appendix VIII S.E.C.I Information 46
Appendix IX Command Line Scripting 63
1. INTRODUCTION

This user guide contains all the information necessary to perform a successful neutron scattering experiment on the OSIRIS spectrometer at the ISIS Facility, RAL, UK. However, to ensure it is as concise as possible, other manuals and reports are referenced for specific details. Copies of all referenced material is either available in the instrument cabin or on the Internet at the given html address. Your Local Contact is also available for assistance and discussion regarding the precise details of the experiment.

This first section highlights the basic underlying physics of OSIRIS operating as a high-resolution quasi / in-elastic spectrometer and high-resolution long-wavelength diffractometer. Section 2, 'Performing an experiment on OSIRIS', details a typical experimental procedure. Finally, sections 3 and 4 discuss computer control as well as data analysis and visualisation.

1.1 THE INSTRUMENT

OSIRIS can be used as either a high-resolution, long-wavelength diffractometer or for high-resolution quasi / in-elastic neutron scattering spectroscopy. With regard spectroscopy, it is an inverted geometry instrument such that neutrons scattered by the sample are energy-analysed by means of Bragg scattering from large-area crystal-analyser array. In common with other instruments at a pulsed neutron-source, the time-of-flight technique is used for data analysis.

The instrument, situated on the N6(B) beam line at ISIS, views a liquid hydrogen moderator cooled to 25 K and consequently has access to a large flux of long-wavelength cold neutrons.

For the purpose of description, OSIRIS may be considered as consisting of two coupled spectrometer components.
i) THE ‘PRIMARY’ SPECTROMETER ( BEAM TRANSPORT)

The ‘primary’ spectrometer is illustrated below in Figure 1.

![Diagram of the OSIRIS primary spectrometer]

*Figure 1 The OSIRIS primary spectrometer*

Neutron beam transport, from moderator to sample position, is achieved using a curved neutron guide. Due to the curvature of the guide no neutron with a wavelength less than approx. 1.5 Å is transported. While the majority of the guide section consists of accurately aligned m=2 super mirror sections (approx. 1m long and rectangular in cross-section), a 1.5m-long converging m=3 guide piece terminates the end. The tapered component helps focus the beam at the sample position (44 mm (high) by 22 mm (wide)) but also serves to increase flux. The incident neutron flux at the sample position is approximately $2.7 \times 10^7 \text{n cm}^{-2} \text{s}^{-1}$ (white beam at full ISIS intensity) with the wavelength intensity distribution at the sample position (up to 12Å) being illustrated in Figure 2. Note, however, that the flux at longer wavelengths (> 12 Å) is still sufficient to detect Bragg peaks with d-spacing close to 17.5 Å (corresponding to ~ 35Å neutrons!!) without significant frame overlap.
The wavelength profile on OSIRIS is illustrated in Figure 2. The increased in intensity on OSIRIS compared to that observed on IRIS is due to the use of the super mirror guide sections from moderator to sample - at present IRIS consists of accurately aligned nickel-plated glass tubes (approx. 1m long and rectangular in cross-section) terminated by a 2.5m-long converging nickel-titanium supermirror section. The flux on HRPD, though much lower for cold neutrons, extends to shorter wavelengths since HRPD views the liquid methane (CH₄) moderator at 100K, which gives an intensity maximum around 2Å.

In practice, the wavelength distribution illustrated above bears little resemblance to that observed in the incident beam monitor during an actual OSIRIS experiment since after leaving the moderator, and depending upon incident energy, each neutron either passes, or is absorbed by, one of two disc-choppers. In brief, the two choppers are used to define the range of neutron energies incident upon the sample during the experiment. Located at approx 6.3m (66 degree aperture) and 10m (98 degree aperture) from the moderator respectively, and operating at either 50, 25, 16.6 or 10 Hz, the choppers themselves are constructed from neutron absorbing material bar a small adjustable aperture through which the neutron may pass. The lower and upper limits of the incident wavelength band are therefore defined by adjusting the chopper phases, and hence opening times of each aperture, with respect to ‘t₀’ (the moment at which neutrons are produced in the target).
effectively defines the energy resolution and energy-transfer range (inelastic) or d-spacing range (elastic) covered during an experiment. Both choppers are synchronised to the ISIS operating frequency (50Hz) with the purpose of the 10m chopper being to avoid potentially problematic ‘frame’ overlap.

ii) THE ‘SECONDARY’ SPECTROMETER

The secondary spectrometer (Figure 3) consists of a 2m diameter vacuum vessel containing a pyrolytic graphite crystal analyser array, a 42-element 3He detector banks and a 8 module (962 ZnS tubes) diffraction detector bank oriented at $2\theta \sim 170^\circ$. The pyrolytic graphite analyser bank is cooled (installation of the cooling circuit is scheduled for mid 2003) close to liquid helium temperature to reduce background contributions from thermal diffuse scattering.

![Figure 3 The OSIRIS secondary spectrometer](image)

The incident beam monitor is placed immediately after the Polariser Interchanger. There is also a transmitted beam monitor in the 'get-lost' tube after the sample bin. Both are glass bead monitors. There are five beads horizontally and 6 vertically and the active component is $^6$Lithium. The monitor efficiencies are wavelength-dependent, but always less than 1% over the range of wavelengths accessible on OSIRIS.
1.2. **PRINCIPLE OF OPERATION**

1.2.1. **QUASI / IN - ELASTIC NEUTRON SCATTERING**

In brief, during quasi / in-elastic neutron scattering experiments, the scattered neutrons are energy-analysed by means of Bragg-scattering from a large array of single crystals (pyrolytic graphite or mica). Only those neutrons with the appropriate wavelength/energy to satisfy the Bragg condition are directed towards the detector bank. By recording the time-of-arrival of each analysed neutron in a detector relative to $t_0$, energy gain/loss processes occurring within the sample may be investigated. The quasi / in-elastic scattering process can be summarised mathematically as follows.

\[ \lambda = \frac{h}{m_n v} \quad \text{(de Broglie)} \]  

\[ \lambda = 2d \sin \theta \quad \text{(Bragg)} \]  

---

**Figure 4** *An indirect-geometry inelastic neutron scattering spectrometer.*

During an OSIRIS experiment, the two disc choppers are used define the finite range of neutron energies incident upon the sample, S,

\[ E = \frac{1}{2} m_n v^2 \quad \text{and} \quad p = m_n v = \frac{h}{\lambda} \quad \text{(de Broglie)} \]

where $m_n$ is the mass of the neutron. Consequently, the time-of-flight, $t_1$, of each neutron along the primary flight path, $L_1$, is variable. However, since only those neutrons with a final energy, $E_2$, that satisfies the Bragg conditions,

\[ \lambda = 2d \sin \theta \quad \text{(Bragg)} \]

are scattered toward the detector bank, D, equations (1) and (2) can be re-formulated to give:
\[ E_2 = \frac{1}{2} m_n \left( \frac{L_2}{t_2} \right)^2 = \frac{1}{2} m_n v^2 = \frac{p^2}{2 m_n} = \frac{1}{2} m_n \left( \frac{h}{\lambda_n} \right)^2 = \frac{1}{2} m_n \left( \frac{h}{2d_n \sin \theta} \right)^2 \]  

(3)

where \( d_n \) is the d-spacing of the analysing crystal.

The distance from the sample position to the detector bank (i.e. the secondary flight path, \( L_2 \)) is accurately known. Consequently, the time, \( t_2 \), it takes for a detected neutron of energy \( E_2 \) to travel a distance \( L_2 \) can be calculated using,

\[ t_2 = \frac{2 m_n L_2 d_n \sin \theta}{h} \]  

(4)

Should interactions within the sample lead to a loss/gain in neutron energy then a distribution of arrival times will result. By measuring the total time-of-flight, \( t (=t_1+t_3) \), and by having accurate knowledge of \( t_2 \), \( L_1 \) and \( L_2 \), the energy exchange within the sample can be determined:

\[ \Delta E = E_1 - E_2 = \frac{1}{2} m_n \left[ \left( \frac{L_1}{t-t_2} \right)^2 - \left( \frac{L_2}{t_2} \right)^2 \right] \]  

(5)

1.2.2. DIFFRACTION

The diffraction detector bank on OSIRIS is used for either simultaneous measurement of structure vs. quasi / in-inelastic information or purely crystallographic determination during a diffraction experiment. Scattered neutrons reach the diffraction detectors directly and time-of-flight analysis is used to determine the d-spacing of the observed Bragg reflections. Here, the scattering geometry is simplified (Figure 5) with the scattering angle, \( 2\theta \), replacing the scattering angle, \( \phi \) shown in the Figure 4.

![Figure 5 A simple diffraction experiment](image-url)
From equations 1 and 2:

$$m_n \left( \frac{L}{t} \right) = \frac{h}{\lambda} = \frac{h}{2d_s \sin \theta}$$

(6)

where $L$ is the total flight-path, $L_1 + L_2$, $t$ is the total flight-time, $t_1 + t_2$, and $d_s$ represents the set of d-spacings measured,

$$d_s = \frac{ht}{2m_n L \sin \theta}$$

(7)

II. PERFORMING AN EXPERIMENT ON OSIRIS

2.1. BEFORE ARRIVING AT THE INSTRUMENT

There are a number of administrative procedures that MUST be followed before arriving at the spectrometer. Failure to do so WILL delay the start of the experiment.

2.1.1. THE USER OFFICE, FILM BADGES AND SWIPE CARDS

Once at ISIS, the user should proceed directly to the User Office (U.O) in R3 to register his/her arrival. First time users will be given an information pack detailing all safety aspects at the facility. The user will also be required to watch the ISIS Safety Video. Once registration is complete, the user will then be directed to the ISIS Main Control room (MCR) in R 5.5 or perhaps the office of his/her Local Contact in R3. Outside office hours the MCR will hand out safety information but at the earliest available opportunity arrival should be registered at the U.O. Before entering building R55 a radiation badge and a ‘swipe-card’ (for entry into the experimental hall) must be obtained from the MCR.

2.1.2. SAMPLE SAFETY ASSESSMENT

As part of the beam time application procedure the ‘Principal Proposer’ will have submitted details concerning the chemical constitution of the sample(s) to be studied. This information is used to perform a sample safety assessment and subsequently generate a
‘sample safety assessment sheet’ detailing possible chemical or radiological hazards associated with the material. Recommended handling procedures after irradiation are also listed and MUST be followed. Before beginning the experiment the user should collect his/her sample safety assessment sheet from the filing cabinet in the Data Assessment Centre (D.A.C, building R55 ) and display it in the pocket beside the sample environment enclosure for the entire duration of the experiment. The user should have viewed the safety video and also read the safety handouts given to them when they arrived.

2.2. SELECTING SAMPLE CANS AND SCATTERING GEOMETRY

Sample can selection is usually determined by the type of experiment to be performed (i.e. diffraction or spectroscopy), form of the sample and/or the sample environment equipment to be used. Two geometries are available: cylindrical or flat plate.

2.2.1. FLAT PLATE CANS FOR QENS/INS EXPERIMENTS

The flat plate cans used on OSIRIS are made of aluminium and allow for a sample with a cross sectional area 40 x 40 mm but of variable thickness. The thickness itself is governed by the sample’s ability to scatter neutrons - a 10-15% scatterer is the ideal since multiple scattering is, in general, not a problem at this level. The optimal thickness of the sample can be roughly calculated using:

\[ I = I_0 \exp(-n\sigma t) \rightarrow t = -\frac{1}{n\sigma} \ln\left(\frac{I}{I_0}\right) \]

where \( I_0 \) is the incident intensity, \( I \) is the transmitted intensity, \( n \) is the number of scattering atoms per unit volume, \( \sigma \) is the 'average' scattering cross-section for the atoms in the sample and \( t \) is the thickness of the sample. For example, for a transmission of 85% (scattering of 15% ignoring absorption processes) then:

\[ t = -\frac{1}{n\sigma} \ln(0.85) \]

More specifically, for polyatomic samples, \( n\sigma = (n_1\sigma_1 + n_2\sigma_2 + n_3\sigma_3 + ...) \). However, in many cases all atoms bar hydrogen may be ignored since H has by far the largest incoherent scattering cross-section.
Flat plate sample cans are sealed using either indium (low temperature work, less than room temperature) or 'o'-rings (high temperature work) and may be used for liquids as well as powders. The advantage of using such cans is that the design specifically incorporates holes for cartridge heaters and temperature sensors enabling quick temperature changes and fine control. However, since the heaters and sensors have to be shielded (using cadmium) scattering in the plane of the sample will be greatly reduced and so sample orientation is important. In general, the sample can is oriented at ±45° relative to the incident neutron beam (straight-through is 0° with exact back scattering being 180° with angles on the graphite side of the instrument are defined as being positive and the angles on the mica side are negative). Which sample can orientation to use depends specifically upon the Q-range and energy-resolution required for the experiment. Cases to consider are:

i) **High-Q**: If high-Q values are required then reflection geometry is best (e.g. plane of sample at +45 such that the 'blind spot' occurs at low angles). Shielding the back of the sample with cadmium will reduce background scattering from the sample environment.

ii) **Low-Q**: If low-Q values are required then transmission geometry should be employed. A sample orientation of +135° is ideal for some magnetic scattering experiments in which the graphite 004 reflection is used (for its larger energy transfer range) but optimising the scattering on the lowest possible Q-values where the magnetic scattering is strongest. It should also be noted that spurious signals due to Bragg scattering would be reduced at low angles.

2.2.2. CYLINDRICAL CANS FOR QENS/INS EXPERIMENTS

The cylindrical sample cans used on OSIRIS are made of aluminium and are 50mm high by 20mm in diameter. For thin samples (0.5 to 2 mm), a hollow cylindrical insert may be placed inside resulting in an annular cross section (as viewed from above). The advantage of this sample geometry is that, unlike the flat plate cans, there are no edge effects and potentially problematic multiple scattering effects are reduced. In addition, sample can orientation is unimportant unless heaters and temperature sensors have been attached - without heaters/sensors there are no 'blind spots' on the analysers.
2.2.3. SAMPLE CANS FOR DIFFRACATION EXPERIMENTS

Cylindrical and flat plate aluminium sample cans can be used for diffraction experiments on OSIRIS. However, such cans should be used when the d spacing region of interest is greater than 2.2 Angstroms since any diffraction pattern collected below this value will exhibit a forest of strong Al Bragg reflections. Ideally, thin walled cylindrical vanadium sample cans should be used. These vary in length from 50mm to 75mm and have diameters ranging from 5mm to 11mm. When working with air sensitive samples they can be fitted with Teflon "O" rings for measurements at room temperature, Cu "O" rings for use in furnaces or indium seals for low temperature measurements.

2.3. LOADING A SAMPLE INTO THE NEUTRON BEAM

Most experiments on OSIRIS utilise the "Orange" cryostat - a card detailing its operation can be found in the pocket attached to the cryostat trolley. If one is not available, inform the Local Contact who will obtain a replacement and/or go through the operation of the cryostat and sample loading procedure. However, should a different piece sample environment equipment be requested (e.g. a CCR or Block heater) the Local Contact will provide assistance loading samples etc. Note: only personnel with a crane operator's licence (see Dennis Abbley for details, x 5455) are permitted to crane sample environment apparatus into and out of the beam line.

2.4. THE BEAM LINE SHUTTER INTERLOCK SYSTEM

The OSIRIS beam line shutter interlock system comprises of two coupled electronic/mechanical control systems; one to control the main shutter and which consequently affects both the IRIS and OSIRIS beam lines (N6A and N6B) and the other associated with only the OSIRIS intermediate shutter. There are very few occasions when it is necessary to open/close the main shutter and this should ONLY be done under the supervision of the Instrument Scientist or Local Contact. For information, main shutter controls can be found beside the IRIS cabin. The user may, however, operate the intermediate shutter control system after suitable instruction. The intermediate shutter control system, found on the instrument platform, consist of three boxes (shutter control, ‘A’ key and master key) and of a
set of interlock keys (a master key (N6B-M) and three ‘A’-keys labelled N6B-A) with corresponding locks.

The Local Contact will point out the location of these boxes and demonstrate how the interlock system operates. However, to summarise, the intermediate shutter cannot be opened unless all four keys are in their appropriate locks in the correct control boxes. Inserting and turning (clockwise) all the ‘A-keys’ in the ‘A-key’ box releases the master key (N6B-M). The master key can then be inserted into the lock in the side of the master key box. Once in position, and turned, the intermediate shutter can be opened by pressing the ‘open’ button on the shutter control box.

Upon pressing ‘open’ the master key is locked into position and cannot be removed until the intermediate shutter is closed. In principle, this means that all active areas on the OSIRIS beam line are inaccessible while the intermediate shutter is open. The area underneath the instrument platform, for will require access for some future instrument configurations, is only accessible with the main shutter has closed. Entry into this area is only allowed under the supervision of the Local Contact or Instrument Scientist.

Regaining access to an interlocked area (e.g. the sample environment enclosure) requires reversal of procedure outlined above. The shutter is closed, the master key is removed and inserted into the ‘A-key’ box which subsequently releases all three the A-keys for access to interlocked areas.

2.5. OSIRIS COMPUTING OVERVIEW

OSIRIS is controlled using a PC running LabView-based instrument and sample environment control software referred to as S.E.C.I (Sample Environment and Control Interface). Detailed information about the S.E.C.I interface can be found in Appendix VII however the basic components of the S.E.C.I are shown in Figure 6. In addition, there is a PC available for data analysis and visualization. RAW data files are copied to this PC once a measurement has ended (files are copied to c:\osiris_raw_files). The S.E.C.I system can be configured to start only those sample environment and/or instrument control components (for example chopper, cryomagnet, dilution refrigerator control software) needed for individual experiments. Those instrument/sample environment components that are active are listed on the left hand side of the S.E.C.I window. The status of the instrument and details about the experiment is displayed on the 'Dashboard' found at the top of the screen (see 3.1.4). Commands to control the instrument are entered into an OpenGenie window.
2.6. SUITABLE INSTRUMENT SETTINGS

OSIRIS can be configured to match the scientific problem under investigation by simply selecting an appropriate resolution and energy-transfer-range or, in the case of diffraction, the appropriate d-spacing range(s). For quasi/in-elastic scattering experiments instrument resolutions is dependant upon the different analyser reflection used. Selecting a particular analyser reflection (and hence resolution) and energy-transfer-range is achieved by defining:

a) the frequency and phases (time-delay settings relative to t₀) of the two disc-choppers and

b) the time-channel-boundaries (TCB’s) for data acquisition.

The procedure is the same for selecting a particular d-spacing range when using the instrument as a diffractometer. Common instrument settings can be found in the Appendix.
along with corresponding chopper frequencies and phases. These settings are ‘loaded’ by
typing single word commands (also given in the Appendix) in the active Open Genie window.
However, occasion may arise when the nature of the problem under investigation warrants
modified setting i.e. the standard settings are inappropriate because of the presence of
spurious peaks. In this case seek advice from the Local Contact or Instrument Scientist.

2.7 DATA COLLECTION

2.7.1. CHANGE INSTRUMENT SETTINGS

As mentioned above, single command words (see Appendices) are used to 'load' the
different parameters for different instrument settings. Consequently, all that is required of the
User is to enter an appropriate title, User names and experiment RB number. No other input is
necessary although information such as type of sample can, orientation and scattering
geometry can also be stored. During the course of an experiment some simple alterations can
be made without aborting or ending a measurement. These can be typed into the active Open
Genie window or issued from a command file, regardless of the state of the DAE (section
3.1.1). For example, the following alters the title of the current experiment:

CHANGE TITLE = "An OSIRIS experiment" <CR>

2.7.2. BEGIN

To start a run type ‘BEGIN’ in the active Open Genie window. After a few seconds
the ‘Dashboard’ should indicate that ‘OSIRIS IS RUNNING’ and the total number of micro-
amps and the monitor counts will begin to increment.

2.7.3. INSPECTING DATA

To inspect a data set while it is still being collected, use the data visualisation
program OPENGENIE on the control PC. Visualisation, and simple manipulation, of spectra
is permissible by entering OPENGENIE commands in the active Open Genie window.

*It is not advisable to perform full data analysis procedures on the instrument control PC.*
For example, to display the monitor spectrum of the data set being collected enter
assign $dae followed by display s(1). Alternatively, to view spectrum 100 of a prior run
type: assign “d:\users\<cycle number>\osi<run number>.raw” and the enter: display
s(100). The more common OpenGenie data manipulation commands are listed in 3.2.1.

Alternatively, the user can enter UPDATESSTORE in the OpenGenie window. This
command suspends data collection by the DAE and copies the contents of the DAE to a file
OSI*****.S’number’ (where ***** = run number and number is incremented each time
UPDATESSTORE is issued during a measurement). Data collection is then resumed and the
file, known as a SAV file, is copied to the OSIRIS analysis PC.

SAV and RAW files, which are copied to the analysis PC once a run is ended, can be
analysed in greater detail using MOSES / MSLICE (spectroscopy) or ARIEL (diffraction
data), see section 3.2.

2.7.4. ‘END’ AND END OF EXPERIMENT

Once the data collected is of sufficient quality for subsequent detailed analysis,
typing END will stop the run and store the data. The data is automatically archived and copies
to the OSIRIS analysis PC. However, before the User leaves the beam line at the end of a
scheduled experimental period, he/she MUST have all irradiated samples monitored for
induced radioactivity. Assistance and advice in this matter may be sought from the ISIS
Health Physics Office (6696) or the ISIS Main Control Room (6789).

<table>
<thead>
<tr>
<th>Radioactivity Level (mSv/hour)</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;10</td>
<td>Phone ISIS duty officer leave sample within interlocked area</td>
</tr>
<tr>
<td>&gt;0.1</td>
<td>Store sample in OSIRIS active sample cupboard with sample record sheet. The sample may NOT be removed from its container. For removal from ISIS contact the duty officer.</td>
</tr>
<tr>
<td>&lt;0.1</td>
<td>The sample is not radioactive. For removal from ISIS contact the duty officer</td>
</tr>
</tbody>
</table>

How to treat radioactive samples (ISIS duty officer x6789).
If the sample is not active it should be removed from its can, the can cleaned ready for the next Users and the sample dealt with as according to the sample safety assessment (i.e. stored at ISIS, removed from ISIS or disposed of by ISIS staff). If removal of the sample from ISIS is required but not immediately possible due to the level of induced activity, arrangements should be made with the Local Contact to remove it at the earliest available opportunity. All active samples should be stored in the ‘Active Sample’ cupboard and **MUST** should be logged in (on storage) and out (upon removal) in the logbook located inside the cupboard. It is not guaranteed that samples will remain stored at ISIS indefinitely so do not forget to leave your e-mail address, so that we can contact you when the sample is safe for you to bring back. It may be possible, with the assistance of Radiation Protection (6696), to package an active sample in such a way as to make its removal from ISIS safe. Before leaving, all film badges and swipe cards should be returned to the MCR.

### III. COMPUTING

#### 3.1. INSTRUMENT CONTROL

##### 3.1.1. DATA ACQUISITION ELECTRONICS

During the course of a run, data is accumulated in the Data Acquisition Electronics (DAE) in a number of spectra, each spectrum corresponding to a particular detector. On OSIRIS there are 1004 spectra. Spectra 1 and 2 are the incident and transmission beam monitors respectively. Spectra 3 to 962 correspond to individual diffraction detectors. Spectra 963 to 1004 relate to the spectroscopy detector bank. Instrument parameters (i.e. flight path, angle) associated with each spectrum are tabulated in the Appendices. Each spectrum contains a histogram of neutron counts versus time-of-flight. At the end of the run the contents of the DAE are automatically copied to a file on the OSIRIS analysis PC called OSI*****.RAW, where '*****' is a five figure run number incremented automatically at the end of each run. Shortly after creation, this RAW file is also archived. The DAE has four possible states:

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SETUP</strong></td>
<td>Data not collected. Instrument parameters may be changed.</td>
</tr>
<tr>
<td><strong>RUNNING</strong></td>
<td>Data is currently being collected and stored in the DAE</td>
</tr>
</tbody>
</table>
Data collection is temporarily suspended by the User

Data collection is temporarily suspended for example, when a cryostat temperature is outside defined limits

3.1.2. INSTRUMENT CONTROL

The instrument control PC is used to start and stop data collection. However, it also allows data collection to be suspended temporarily to allow, for example, entry into an interlocked area. Data collection can also be suspended automatically if the sample environment control system (section 3.1.5) indicates that, for example, the temperature has drifted outside of pre-defined limits. Commonly used instrument control commands include:

**BEGIN**
- Clears the DAE memory, sets parameters in the DAE to those specified, instructs the DAE to start data collection.
- Sets DAE state to RUNNING on the ‘dashboard’

**PAUSE**
- Suspends data collection by the DAE. Sets DAE state to PAUSED

**RESUME**
- Resumes data collection by the DAE. Sets DAE state to RUNNING

**UPDATESTORE**
- Suspends data collection by the DAE. Copies the contents of the DAE. Restarts data collection by the DAE. The contents of the DAE are written to the file OSI*****.S’number’ (where ***** = run number and number is incremented each time UPDATESTORE is issued during a measurement).

**ABORT**
- Stops data collection by the DAE. Does NOT store data. Sets DAE state to SETUP.

**END**
- Stops data collection by the DAE. Copies the contents of the DAE memory to file OSI*****.RAW. Increments the run number ‘*****’. Sets DAE state to SETUP.
The ABORT command does not store the accumulated data and so should only be used if it is certain that the data is not needed.

3.1.3. THE DASHBOARD

As mentioned in section 2.5, the OSIRIS ‘Dashboard’ (Figure 6) displays information about the current run such as current DAE state (RUNNING, SETUP, etc.) and run number.

In addition, information concerning the User, sample, run time, frame (proton pulse) count, present and accumulated proton beam current, the incident beam monitor counts and any sample environment parameters being monitored is also displayed.

![Figure 7 The OSIRIS S.E.C.I Dashboard](image)

3.1.4. S.E.C.I AND EUROTHERM

A complete overview of the Sample Environment Control Interface (S.E.C.I) can be found in Appendix VII. However, the basic commands necessary for temperature control are outlined in the following section. The temperature of the sample and/or sample environment equipment can be set, as well as logged, from the instrument control PC and any computer terminal ‘connected’ to the OSIRIS control PC using a VNC connection. Each time an OSIRIS run is ended the temperature log files are closed and new ones are opened. The log files are called, for example, OSI*****_<block name>.TXT where ' ***** ' is the run number. The log files are written to the OSIRIS analysis PC along with the RAW file. In addition to the RAW and SAVE files and the file, JOURNAL.TXT, is also copied to the
analysis PC. JOURNAL.TXT contains a list (Date, Run No, Users, Title, Run Duration and uamps) of all OSIRIS experiments performed to date.

In addition, data collection can be temporarily suspended when the temperature drifts outside of a specified range. There are essentially three aspects to the temperature control system. The control PC (for issuing the commands), the CAMAC unit (hardware/software interface) and the Eurotherm temperature controllers. The temperature controllers measure the millivolt output from resistance thermometers (Rh/Fe or Pt) or thermocouples (usually type-K) and control the temperature at a specified set point using a 3-term control algorithm (proportional band, integral time and derivative time - commonly referred to as PID control). The conversion from millivolts to K or C is achieved using ‘look-up’ tables held on the mainframe (each Rh/Fe sensor for example is calibrated at a number of points and has its own conversion table and identification number). While the unit of temperature (K or C) depends upon the sample environment equipment being used it would normally be Kelvin for a cryostat and Celsius for a furnace. The ‘Dashboard’ usually displays both the millivolt readings and the corresponding K or C value. TEMP1 and TEMP2 are examples of two software temperature control blocks in S.E.C.I that correspond to the two EUROTHERM temperature controllers.

3.1.6. TEMPERATURE CONTROL

Listed below are the more useful commands in the S.E.C.S relating to the control of temperature: The controls are entered in the active Open Genie window.

\[\text{CSET TEMP1}=10\] Sets temperature observed temperature control block, TEMP1, to 10 K.

\[\text{CSHOW TEMP1}\] Displays information about the current status of TEMP1.

\[\text{CSET/CONTROL TEMP1} = 15 \text{ LOWLIMIT} = 10 \text{ HIGHLIMIT} = 20\]
This command issues a set point value of 15 (K or C) to temperature control block TEMP1. The controller attempts to maintain a temperature of 15 +/- 5 (K or (C) as denoted by the ‘limits’. LOWLIMIT and HIGHLIMIT are used to inhibit data collection because of the /CONTROL prompt. If TEMP1 varies outside this range OSIRIS go into the WAITING state until the value returns into the range.

**CSET/NOCONTROL TEMP1**

Data collection vetoing is disabled if TEMP1 falls outside HIGHLIMIT or LOWLIMIT.

**SETEURO1 P=1 D=1 I=1**

Sets P.I.D values on Eurotherm controller No 1. P=Proportional, I=Integral and D=Derivative bands. Can also set max power (MP=100) and auto tune (AT)

**Suitable P.I.D values for the different sample environment apparatus used on OSIRIS are listed in Appendix IV**

3.1.7. COMMAND FILES

Automatic control of OSIRIS can be achieved using a simple user written command file. Based on OpenGenie code, command files are created using either Notepad or Wordpad and saved as a .GCL file in the Users area on the U: drive. An simple example .GCL file is given on the next page:
PROCEDURE Example
# Measure at T=1.5K on d-range 1 and T=10K on d-range 2
ctset/control temp1=1.5 highlimit=3.0 lowlimit=1.0
drange 1
begin
change title = "An OSIRIS experiment at T=1.5K d1"
waitfor uAmps = 50
end
ENDPROCEDURE

To load a GCL command, type

LOAD "<file.gcl>"

into the active Open Genie window. A GCL command file will not run unless it loads into Open Genie without error.

3.2. DATA VISUALISATION AND ANALYSIS

Data visualisation, and subsequent analysis, on OSIRIS utilises PC based software. A brief description of the four main software packages, and links to further information, is given below.

NOTE: DO NOT use the OSIRIS control PC for data analysis

3.2.1 DATA ANALYSIS AND REDUCTION SOFTWARE

- OPENGENIE

OPENGENIE is an ISIS developed data visualisation package common to all ISIS instruments. It is used for displaying and manipulating spectra and data sets. A comprehensive overview of OPENGENIE can be found at

http://www.isis.rl.ac.uk/OpenGENIE/

To start OPENGENIE click on the ‘OPENGENIE’ icon on the analysis PC desktop. Useful data visualisation commands include (older GENIE syntax is also included):
<table>
<thead>
<tr>
<th><strong>GENIE v2 Command</strong></th>
<th><strong>Open GENIE Command</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>a b N (N=1,2,3,…)</td>
<td>a/b N</td>
<td>alter binning</td>
</tr>
<tr>
<td>a m N</td>
<td>a/m N</td>
<td>alter markers</td>
</tr>
<tr>
<td>ass</td>
<td>ass</td>
<td>Assign</td>
</tr>
<tr>
<td>d/h/l/m/e</td>
<td>d/h/l/m/e</td>
<td>Display</td>
</tr>
<tr>
<td>l</td>
<td>l</td>
<td>Limits</td>
</tr>
<tr>
<td>m</td>
<td>m</td>
<td>Multiplot</td>
</tr>
<tr>
<td>c/v/h</td>
<td>c/v/h</td>
<td>Cursor</td>
</tr>
<tr>
<td>ex</td>
<td>ex</td>
<td>Exit</td>
</tr>
<tr>
<td>j “OS command”</td>
<td>j “OS command”</td>
<td>Jump</td>
</tr>
<tr>
<td>k/h</td>
<td>k/h</td>
<td>keep hardcopy</td>
</tr>
<tr>
<td>p/h/l/m/e</td>
<td>p/h/l/m/e</td>
<td>Plot</td>
</tr>
<tr>
<td>reb</td>
<td>reb</td>
<td>Rebin</td>
</tr>
<tr>
<td>set disk my$disk</td>
<td>set/disk “my$disk:”</td>
<td>set disk</td>
</tr>
<tr>
<td>set dir [mydir]</td>
<td>set/dir “[mydir]”</td>
<td>set directory</td>
</tr>
<tr>
<td>set ext raw</td>
<td>set/ext “raw”</td>
<td>set extension</td>
</tr>
<tr>
<td>set inst ANY</td>
<td>set/inst “ANY”</td>
<td>set instrument</td>
</tr>
<tr>
<td>set par</td>
<td>setpar</td>
<td>set wksp parameters</td>
</tr>
<tr>
<td>set title w1</td>
<td>w1.title=</td>
<td>set title</td>
</tr>
<tr>
<td>sh data</td>
<td>sh/data</td>
<td>show data</td>
</tr>
<tr>
<td>sh par</td>
<td>sh/par</td>
<td>show parameters</td>
</tr>
<tr>
<td>sh def</td>
<td>sh/def</td>
<td>show defaults</td>
</tr>
<tr>
<td>u/?</td>
<td>u/?</td>
<td>Units</td>
</tr>
<tr>
<td>z</td>
<td>z</td>
<td>Zoom</td>
</tr>
</tbody>
</table>

- **ARIEL**

ARIEL is the preferred package for the reduction of diffraction data collected on OSIRIS (i.e. reducing the data to GSAS, CCSL or some other portable format). ARIEL runs under IDL. For details about how to use AREIL see:

[http://www.isis.rl.ac.uk/disordered/gem/Software/Ariel3.1release.htm](http://www.isis.rl.ac.uk/disordered/gem/Software/Ariel3.1release.htm)
• LAMP

LAMP is an alternative package for the reduction of diffraction data collected on OSIRIS (i.e. reducing the data to GSAS, CCSL or some other portable format). LAMP runs under IDL with a convenient syntax for manipulating neutron data. For details about how to use LAMP see:

http://www.isis.rl.ac.uk/molecularspectroscopy/osiris/osiris_dataanalysis.htm

However, the LAMP code is no longer supported at ISIS and as a result this package is to be superseded by ARIEL

• MOSES

MOSES is a suite of programs for the full reduction and analysis of OSIRIS spectroscopy data. An online MOSES manual can be found at:

http://www.isis.rl.ac.uk/molecularspectroscopy/osiris/

A more in-depth descriptions of the individual analysis programs themselves can be in the GUIDE and IDA manuals. These can be found online at:

http://sutekh.nd.rl.ac.uk/wsh/index.html

MOSES can be launched by typing clicking on the ‘MOSES’ icon on the OSIRIS analysis PC desktop

• MSLICE

MSLICE is a MatLab based analysis tool predominately used for the visualisation and analysis of magnetic excitations. MOSES is used to convert the RAW data to a format that can be read by MSLICE. Information about MSLICE can be found at:

http://www.isis.rl.ac.uk/excitations/index.htm
IV. REFERENCES


iii) GSAS user guides, software and information: [http://public.lanl.gov/gsas/](http://public.lanl.gov/gsas/)

iv) Cambridge Crystallography Subroutine Library (CCSL) information: [http://www.isis.rl.ac.uk/crystallography/documentation/CCSL/CCSLguideFramePage.htm](http://www.isis.rl.ac.uk/crystallography/documentation/CCSL/CCSLguideFramePage.htm)

### APPENDIX I - QUASI / IN ELASTIC SETTINGS.

<table>
<thead>
<tr>
<th>Analyser</th>
<th>Fwhm (μeV)</th>
<th>ΔE (meV)</th>
<th>Freq</th>
<th>Detector TCB (μs)</th>
<th>Mon TCB (μs)</th>
<th>Mon Bounds (μs)</th>
<th>Phases $\theta_{6.3}/\theta_{10}$ (μs)</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>002</td>
<td>24.5</td>
<td>-0.4 to 0.4</td>
<td>50</td>
<td>51500.0</td>
<td>45900.0</td>
<td>58732.0</td>
<td>8573</td>
<td>PG002</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>71500.0</td>
<td>65900.0</td>
<td>60732.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>002</td>
<td></td>
<td>-0.7 to 0.8</td>
<td>25</td>
<td>40200.0</td>
<td>36800.0</td>
<td>66177.0</td>
<td>6052</td>
<td>PG002_25Hz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>80200.0</td>
<td>76800.0</td>
<td>68177.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>002</td>
<td></td>
<td>-0.2 to 1.2</td>
<td>50</td>
<td>45500.0</td>
<td>40400.0</td>
<td>53055.0</td>
<td>7500</td>
<td>PG002_OFFSET</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>65500.0</td>
<td>60400.0</td>
<td>55055.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>002</td>
<td></td>
<td>-0.7 to 0.1</td>
<td>50</td>
<td>58700.0</td>
<td>52000.0</td>
<td>65545.0</td>
<td>9738</td>
<td>PG002_OFFSET1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>78700.0</td>
<td>72000.0</td>
<td>67545.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>-1.0 to 1.0</td>
<td>25</td>
<td>57300.0</td>
<td>49400.0</td>
<td>64220.0</td>
<td>8964</td>
<td>PG002_OFFSET2_25Hz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>97300.0</td>
<td>89400.0</td>
<td>66220.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>-0.1 – 25.0</td>
<td>16.6</td>
<td>15000.0</td>
<td>14000.0</td>
<td>50817.0</td>
<td>1500</td>
<td>PG002_OFFSET3_16Hz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>75000.0</td>
<td>75000.0</td>
<td>52817.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>-0.05 to 2.0</td>
<td>50</td>
<td>40500.0</td>
<td>35300.0</td>
<td>48323.0</td>
<td>6569</td>
<td>PG002_OFFSET4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>60500.0</td>
<td>55300.0</td>
<td>50323.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>-0.3 to 1.0</td>
<td>50</td>
<td>48500.0</td>
<td>43600.0</td>
<td>48323.0</td>
<td>8207</td>
<td>PG002_OFFSET5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>68500.0</td>
<td>63600.0</td>
<td>50323.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>004</td>
<td>99</td>
<td>-3.0 to 4.0</td>
<td>50</td>
<td>22500.0</td>
<td>19000.0</td>
<td>31291.0</td>
<td>3717</td>
<td>PG004</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>42500.0</td>
<td>39000.0</td>
<td>33291.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>004</td>
<td></td>
<td>-2.0 to 7.0</td>
<td>50</td>
<td>20500.0</td>
<td>16700.0</td>
<td>29398.0</td>
<td>3217</td>
<td>PG004_OFFSET1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>40500.0</td>
<td>36700.0</td>
<td>31398.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 1** Standard Quasi / In-elastic settings
The diffraction detectors are placed in a ring around the incident beam. They cover the full range of scattering angles \(2\theta\) from 150º to 171º, providing a total solid angle coverage of 0.67 steradians.

![Diagram of diffraction modules](image)

**Figure 8:** Diffraction modules as seen from the sample position

<table>
<thead>
<tr>
<th>Module</th>
<th>Detectors</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3 - 122</td>
</tr>
<tr>
<td>2</td>
<td>123 - 242</td>
</tr>
<tr>
<td>3</td>
<td>243 - 362</td>
</tr>
<tr>
<td>4</td>
<td>363 - 482</td>
</tr>
<tr>
<td>5</td>
<td>483 - 602</td>
</tr>
<tr>
<td>6</td>
<td>603 - 722</td>
</tr>
<tr>
<td>7</td>
<td>723 - 842</td>
</tr>
<tr>
<td>8</td>
<td>843 - 962</td>
</tr>
</tbody>
</table>

The detectors are shown schematically above and as seen from the sample position. They are scintillators and the full detector bank contains 8 modules, numbered according to the order in which they were installed. Each module consists of 120 detector elements. The first 20 are single detectors. Between 21 and 120 the even numbered detectors are still single but the odd numbered are physically composed of one detector above and one below the central strip, hardwired together, as shown for module 1 below.
The choppers typically run at a frequency of 25 Hz, which allows a 4 Å wide wavelength range to reach the sample with minimal contamination from other wavelengths. The d-spacing measured are given by Bragg’s law: \( \lambda = 2d \sin \theta \) and since the diffraction detectors are close to backscattering (\( \Rightarrow \sin \theta \approx 1 \)) the d-spacing is about half the neutron wavelength. The range of d-spacing measured with the choppers at 25Hz is thus about 2 Å wide. In order to measure a full range of d-spacing to properly characterise the sample, a series of runs are usually performed with an incremental increase of the chopper phasing. The data from these runs are then merged in software to create a data set that spans the full range of d-spacing of interest in a continuous manner.

The combination of a cold moderator and a super mirror guide provides a high flux of cold neutrons on OSIRIS. However, while neutron wavelengths of up to 70Å re accessible, 35Å is the experimental limit. The reduction in flux at long wavelengths is partly compensated for by the \( \lambda^4 \) form factor that applies to Bragg peak intensities. The use of a super mirror guide significantly enhances the neutron flux at all wavelengths, but at a price in beam divergence, which increases substantially as a function of wavelength. This is why the diffraction detectors on OSIRIS only cover the highest scattering angles, where beam divergence does not contribute greatly to the instrumental d-spacing resolution. At \( \Delta d/d \) down to \( 2.5 \times 10^{-3} \), OSIRIS provides similar resolution to the HRPD 90° bank with the same counting rate as on GEM. OSIRIS can reach d-spacings in excess of 30 Å with high resolution, but cannot access d-spacing below about 0.9 Å, due to the curved guide cut off.

\[ \lambda = 2d \sin \theta \]

\[ \Delta d/d \]
<table>
<thead>
<tr>
<th>drange</th>
<th>Total d-spacing range (Å)</th>
<th>Ariel d-spacing range (Å)</th>
<th>$Q / \ \AA^{-1}$</th>
<th>Time-channel-boundaries (μS)</th>
<th>Phases (μS) $\theta_{6.3} / \theta_{10}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.70 - 2.90</td>
<td>0.7 – 2.5</td>
<td>8.9771 - 2.5136</td>
<td>11700 - 51700</td>
<td>1011/1566</td>
</tr>
<tr>
<td>2</td>
<td>1.80 - 4.00</td>
<td>2.1 – 3.3</td>
<td>2.9924 - 1.9042</td>
<td>29400 - 69400</td>
<td>4599/7715</td>
</tr>
<tr>
<td>3</td>
<td>2.90 - 4.90</td>
<td>3.1 - 4.3</td>
<td>2.0271 - 1.4614</td>
<td>47100 - 87100</td>
<td>7590/12859</td>
</tr>
<tr>
<td>4</td>
<td>3.70 - 6.00</td>
<td>4.1 – 5.3</td>
<td>1.5327 - 1.1857</td>
<td>64800 - 104800</td>
<td>10407/17715</td>
</tr>
<tr>
<td>5</td>
<td>4.90 - 7.00</td>
<td>5.2 – 6.2</td>
<td>1.2085 - 1.0135</td>
<td>82500 - 122500</td>
<td>13015/22800</td>
</tr>
<tr>
<td>6</td>
<td>5.70 - 8.00</td>
<td>6.2 – 7.3</td>
<td>1.0135 - 0.8608</td>
<td>100200 - 140200</td>
<td>16100/27973</td>
</tr>
<tr>
<td>7</td>
<td>7.00 - 9.00</td>
<td>7.3 – 8.3</td>
<td>0.8608 - 0.7571</td>
<td>117900 - 157900</td>
<td>19480/33251</td>
</tr>
<tr>
<td>8</td>
<td>8.10 - 10.00</td>
<td>8.3 – 9.5</td>
<td>0.7571 - 0.6615</td>
<td>135500 - 175500</td>
<td>22571/38130</td>
</tr>
<tr>
<td>9</td>
<td>8.70 - 11.00</td>
<td>9.4 – 10.6</td>
<td>0.6685 - 0.5928</td>
<td>153200 - 193200</td>
<td>26062/3609</td>
</tr>
<tr>
<td>10</td>
<td>10.2 - 12.00</td>
<td>10.4 – 11.6</td>
<td>0.6042 - 0.5417</td>
<td>170900 - 210900</td>
<td>28953/8228</td>
</tr>
<tr>
<td>11</td>
<td>10.80 - 13.00</td>
<td>11.0 – 12.5</td>
<td>0.5713 - 0.5027</td>
<td>188600 - 228600</td>
<td>32144/13367</td>
</tr>
</tbody>
</table>

Table 2: Standard Diffraction Settings at 25Hz

- **drange** is used to change chopper phases and load new time channel boundaries.

NB: include the string dN in the run title to enable Ariel to stitch the data sets together. For example: “Aluminium d4 Room Temperature”
Figure 10: Low d-spacing background features observed when measuring i) the 5mm diameter vanadium standard and b) the empty sample bin. The effect of coving the sample bin’s aluminium exit window with gadolinium foil is also illustrated. Al = Aluminium, V = vanadium, Gd = gadolinium
APPENDIX III - INSTRUMENT PARAMETERS.

Operating vacuum: 
2 x 10^{-6} mb (instrument tank, analyser ON) 
3 x 10^{-5} mb (instrument tank, analyser OFF) 
4 x 10^{-5} mb (sample environment bin) 

Primary instrument flight-path: \( L_1 = 34.00 \text{ m} \)

Inelastic:

Analysing energy (for graphite at 8K, PG002): 1.845 meV
Analysing energy (for graphite at 8K, PG004): 7.375 meV
Average secondary flight-path: \( L_2 = 1.582 \text{ m} \)
Angular coverage of \(^3\text{He} \) detector bank: 11° < 2θ < 155°
Spectrum numbers: 963 to 1004

Diffraction:

Average secondary flight path: \( L_2 = 1.005 \text{ m} \)
Angular range of diffraction detectors: 167.1° < 2θ < 172.4°
Resolution: \( 5 \times 10^{-3} < \Delta d/d < 6 \times 10^{-3} \)
Solid angle: 0.67 steradians
d-spacing range: 0.8 Å < d < ~35 Å
Spectrum numbers: 3 to 962
Figure 11: Momentum transfer vs. scattering angle for the OSIRIS pyrolytic graphite analyser bank. The Q values are those calculated at the elastic line i.e. $K_i = K_f$ Exact values are given in the table below.
<table>
<thead>
<tr>
<th>Detector No.</th>
<th>Spectra Number</th>
<th>2θ (degrees)</th>
<th>Q Value (002)</th>
<th>Q Value (004)</th>
</tr>
</thead>
<tbody>
<tr>
<td>963</td>
<td>963</td>
<td>11.50</td>
<td>0.18</td>
<td>0.37</td>
</tr>
<tr>
<td>964</td>
<td>964</td>
<td>14.82</td>
<td>0.24</td>
<td>0.48</td>
</tr>
<tr>
<td>965</td>
<td>965</td>
<td>18.15</td>
<td>0.29</td>
<td>0.59</td>
</tr>
<tr>
<td>966</td>
<td>966</td>
<td>21.48</td>
<td>0.35</td>
<td>0.69</td>
</tr>
<tr>
<td>967</td>
<td>967</td>
<td>24.81</td>
<td>0.40</td>
<td>0.80</td>
</tr>
<tr>
<td>968</td>
<td>968</td>
<td>28.14</td>
<td>0.45</td>
<td>0.91</td>
</tr>
<tr>
<td>969</td>
<td>969</td>
<td>31.47</td>
<td>0.51</td>
<td>1.01</td>
</tr>
<tr>
<td>970</td>
<td>970</td>
<td>34.80</td>
<td>0.56</td>
<td>1.12</td>
</tr>
<tr>
<td>971</td>
<td>971</td>
<td>38.17</td>
<td>0.61</td>
<td>1.22</td>
</tr>
<tr>
<td>972</td>
<td>972</td>
<td>41.46</td>
<td>0.66</td>
<td>1.32</td>
</tr>
<tr>
<td>973</td>
<td>973</td>
<td>44.79</td>
<td>0.71</td>
<td>1.43</td>
</tr>
<tr>
<td>974</td>
<td>974</td>
<td>48.12</td>
<td>0.76</td>
<td>1.53</td>
</tr>
<tr>
<td>975</td>
<td>975</td>
<td>51.45</td>
<td>0.81</td>
<td>1.62</td>
</tr>
<tr>
<td>976</td>
<td>976</td>
<td>54.78</td>
<td>0.86</td>
<td>1.72</td>
</tr>
<tr>
<td>977</td>
<td>977</td>
<td>58.10</td>
<td>0.91</td>
<td>1.82</td>
</tr>
<tr>
<td>978</td>
<td>978</td>
<td>61.43</td>
<td>0.96</td>
<td>1.91</td>
</tr>
<tr>
<td>979</td>
<td>979</td>
<td>64.76</td>
<td>1.00</td>
<td>2.01</td>
</tr>
<tr>
<td>980</td>
<td>980</td>
<td>68.09</td>
<td>1.05</td>
<td>2.10</td>
</tr>
<tr>
<td>981</td>
<td>981</td>
<td>71.42</td>
<td>1.09</td>
<td>2.19</td>
</tr>
<tr>
<td>982</td>
<td>982</td>
<td>74.75</td>
<td>1.14</td>
<td>2.27</td>
</tr>
<tr>
<td>983</td>
<td>983</td>
<td>78.08</td>
<td>1.18</td>
<td>2.36</td>
</tr>
<tr>
<td>984</td>
<td>984</td>
<td>81.41</td>
<td>1.22</td>
<td>2.44</td>
</tr>
<tr>
<td>985</td>
<td>985</td>
<td>84.74</td>
<td>1.26</td>
<td>2.52</td>
</tr>
<tr>
<td>986</td>
<td>986</td>
<td>88.07</td>
<td>1.30</td>
<td>2.60</td>
</tr>
<tr>
<td>987</td>
<td>987</td>
<td>91.40</td>
<td>1.34</td>
<td>2.68</td>
</tr>
<tr>
<td>988</td>
<td>988</td>
<td>94.73</td>
<td>1.38</td>
<td>2.76</td>
</tr>
<tr>
<td>989</td>
<td>989</td>
<td>98.06</td>
<td>1.42</td>
<td>2.83</td>
</tr>
<tr>
<td>990</td>
<td>990</td>
<td>101.30</td>
<td>1.45</td>
<td>2.90</td>
</tr>
<tr>
<td>991</td>
<td>991</td>
<td>104.71</td>
<td>1.49</td>
<td>2.97</td>
</tr>
<tr>
<td>992</td>
<td>992</td>
<td>108.04</td>
<td>1.52</td>
<td>3.03</td>
</tr>
<tr>
<td>993</td>
<td>993</td>
<td>111.37</td>
<td>1.55</td>
<td>3.10</td>
</tr>
<tr>
<td>994</td>
<td>994</td>
<td>114.70</td>
<td>1.58</td>
<td>3.16</td>
</tr>
<tr>
<td>995</td>
<td>995</td>
<td>118.03</td>
<td>1.61</td>
<td>3.21</td>
</tr>
<tr>
<td>996</td>
<td>996</td>
<td>121.36</td>
<td>1.64</td>
<td>3.27</td>
</tr>
<tr>
<td>997</td>
<td>997</td>
<td>124.69</td>
<td>1.66</td>
<td>3.32</td>
</tr>
<tr>
<td>998</td>
<td>998</td>
<td>128.02</td>
<td>1.69</td>
<td>3.39</td>
</tr>
<tr>
<td>999</td>
<td>999</td>
<td>131.35</td>
<td>1.71</td>
<td>3.42</td>
</tr>
<tr>
<td>1000</td>
<td>1000</td>
<td>134.68</td>
<td>1.73</td>
<td>3.46</td>
</tr>
<tr>
<td>1001</td>
<td>1001</td>
<td>138.01</td>
<td>1.75</td>
<td>3.50</td>
</tr>
<tr>
<td>1002</td>
<td>1002</td>
<td>141.34</td>
<td>1.77</td>
<td>3.54</td>
</tr>
<tr>
<td>1003</td>
<td>1003</td>
<td>144.67</td>
<td>1.79</td>
<td>3.57</td>
</tr>
<tr>
<td>1004</td>
<td>1004</td>
<td>148.00</td>
<td>1.81</td>
<td>3.60</td>
</tr>
</tbody>
</table>
APPENDIX IV - P.I.D PARAMETERS

PROP = PROPORTIONAL BAND

INT = INTEGRAL TIME

DERIV = DERIVATIVE TIME

** As temperature increases ‘INT’ and ‘DERIV’ should be progressively decreased but keeping to a 6:1 ratio

### Orange Cryostat

<table>
<thead>
<tr>
<th>Temp (K)</th>
<th>Prop (%)</th>
<th>Int (s)</th>
<th>Deriv (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 – 5</td>
<td>3</td>
<td>1</td>
<td>0.17</td>
</tr>
<tr>
<td>5 – 10</td>
<td>3</td>
<td>10</td>
<td>1.67</td>
</tr>
<tr>
<td>10 – 20</td>
<td>1</td>
<td>10</td>
<td>1.67</td>
</tr>
<tr>
<td>20 - 300</td>
<td>1</td>
<td>50</td>
<td>8.3</td>
</tr>
</tbody>
</table>

### Orange Cryostat (control on the sample)

<table>
<thead>
<tr>
<th>Temp (K)</th>
<th>Prop (%)</th>
<th>Int (s)</th>
<th>Deriv (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - 20</td>
<td>2</td>
<td>40</td>
<td>6.7</td>
</tr>
<tr>
<td>20 - 50</td>
<td>2</td>
<td>100</td>
<td>16.7</td>
</tr>
<tr>
<td>50 - 100</td>
<td>2</td>
<td>200</td>
<td>33.3</td>
</tr>
<tr>
<td>150 - 300</td>
<td>2</td>
<td>999</td>
<td>166.5</td>
</tr>
</tbody>
</table>

### CCR

<table>
<thead>
<tr>
<th>Temp (K)</th>
<th>Prop (%)</th>
<th>Int (s)</th>
<th>Deriv (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 – 50</td>
<td>2</td>
<td>50</td>
<td>8.3</td>
</tr>
<tr>
<td>50 – 150</td>
<td>2</td>
<td>100</td>
<td>16.7</td>
</tr>
<tr>
<td>150 –300</td>
<td>2</td>
<td>200</td>
<td>33.3</td>
</tr>
</tbody>
</table>
Normal working hours for most ISIS staff (apart from the ISIS crew who are on shift duty) are from 08:30 to 17:00 (Mon to Fri). Outside these hours most local contacts at ISIS, including many members of the technical support groups, voluntarily agree to provide some form of out-of-hours User support. The first point of call (after this manual) should be the Local Contact for the experiment, assistance being available during ‘reasonable’ hours. The definition of ‘reasonable’ depends upon the individual concerned. However, as a general rule, for local contacts on OSIRIS and members of the technical support groups, the hours between 08:00 and 23:00 would probably be deemed reasonable. Unless it has been agreed that a person may be contacted outside of these hours then the following procedure should be adopted:

i) Check the manual for possible solutions and explanations.

ii) Investigate whether the problem can be put off until a more reasonable time e.g. can the experimental timetable be adjusted by, perhaps, performing a background or a resolution measurement?

iii) Is a member of the ISIS crew able to assist with the problem?

iv) If none of the above apply ensure that the experimental set-up is safe (the ISIS duty officer in the MCR will advise if necessary) and wait until a more reasonable time. Loss of beam time due to ISIS/OSIRIS/Sample Environment problems is always dealt with sympathetically and, if appropriate, the lost beam time will be is rescheduled at a later date.
## APPENDIX VI - USEFUL TELEPHONE NUMBERS

### General:

<table>
<thead>
<tr>
<th>Service</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accident/Emergency/Fire</td>
<td>2222</td>
</tr>
<tr>
<td>Health Physics (Radiation)</td>
<td>6696</td>
</tr>
<tr>
<td>ISIS Main Control Room (MCR)</td>
<td>6789</td>
</tr>
<tr>
<td>OSIRIS Cabin</td>
<td>6896</td>
</tr>
<tr>
<td>Main gate (Security)</td>
<td>5545</td>
</tr>
<tr>
<td>Computer support</td>
<td>1763</td>
</tr>
</tbody>
</table>

### Office numbers:

<table>
<thead>
<tr>
<th>Office</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dr Mark Telling</td>
<td>5529</td>
</tr>
<tr>
<td>Dr Vicky Garcia-Sakai</td>
<td>6703</td>
</tr>
<tr>
<td>Dr Felix Fernandez-Alonso</td>
<td>8203</td>
</tr>
<tr>
<td>Dr Franz Demmel</td>
<td>8283</td>
</tr>
</tbody>
</table>
APPENDIX VII. – USEFUL DIAGRAMS

Kelvinox Dilution Fridge Details
STAMP OR ENGRAVE '2.0'
IN 2mm HIGH MAX CHARACTERS
MID POSN ON FLANGE

R 0.5 MAX

1 x 45°
0.5 x 45°
7
60.4
60.5

SECTION ON δ

0.5 x 45°
POSN

R 0.5

4

62

8 DRILL #3.4 THRU EQUI-
SPACED ON 38.0 PCD

INNER SLEEVE (2.0 SAMPLE)
ANNULAR CELL
SAMPLE ENVIRONMENT
CAD drawing numbers for 50 mm x 40 mm OSIRIS flat plate sample cans

<table>
<thead>
<tr>
<th>Flat plate (csk) Common to assemblies</th>
<th>Si-4206-307</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window frame 0.1 mm</td>
<td>Si-4206-308</td>
</tr>
<tr>
<td>Window frame 0.2</td>
<td>Si-4206-309</td>
</tr>
<tr>
<td>Window frame 0.3</td>
<td>Si-4206-310</td>
</tr>
<tr>
<td>Window frame 0.4</td>
<td>Si-4206-311</td>
</tr>
<tr>
<td>Window frame 0.5</td>
<td>Si-4206-312</td>
</tr>
<tr>
<td>Window frame 1.0</td>
<td>Si-4206-313</td>
</tr>
<tr>
<td>Window frame 2.0</td>
<td>Si-4206-314</td>
</tr>
</tbody>
</table>

CAD drawing numbers for 50 mm x 26 mm OSIRIS flat plate sample cans

<table>
<thead>
<tr>
<th>Flat plate (csk) Common to assemblies</th>
<th>Si-4206-322</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window frame 0.1 mm</td>
<td>Si-4206-323</td>
</tr>
<tr>
<td>Window frame 0.2</td>
<td>Si-4206-324</td>
</tr>
<tr>
<td>Window frame 0.3</td>
<td>Si-4206-325</td>
</tr>
<tr>
<td>Window frame 0.4</td>
<td>Si-4206-326</td>
</tr>
<tr>
<td>Window frame 0.5</td>
<td>Si-4206-327</td>
</tr>
<tr>
<td>Window frame 1.0</td>
<td>Si-4206-328</td>
</tr>
<tr>
<td>Window frame 2.0</td>
<td>Si-4206-329</td>
</tr>
</tbody>
</table>
APPENDIX VIII - S.E.C.I INFORMATION

INTRODUCTION

The Sample Environment Control Interface (S.E.C.I) programme’s main role is to manage the instrument control software; essentially, S.E.C.I is responsible for organising and displaying the software that actually runs the experiment, such as Labview etc. S.E.C.I was developed in-house at ISIS in an attempt to meet the unique requirements of the experiments carried out on-site.

WHAT IS S.E.C.I

In basic terms S.E.C.I is made up of three parts, these are the dashboard, the tree-view and the configuration files.
The dashboard appears at the top of the screen and provides an overview of the instrument status. The dashboard itself is divided up into three main parts (from left to right):

• The error box - any errors that occur in the experiment are listed in this box

• The main status panel - lists a number of experimental values (examples: run-time, beam current, number of counts etc) which are updated every two seconds.

• The block list – this area can be customised to list experimental values which are not included in the main status panel.

The tree-view groups the experiment into manageable pieces, which can be viewed separately from each other. By selecting the appropriate node on the tree, S.E.C.I hides all the other nodes and only displays the selected one. The contents of the nodes are customisable, for example: all the control panels for the experiment can be grouped under one node or alternatively, they could be grouped by type or even individually.

The configuration files are text files that are used to set-up S.E.C.I for different experiments or instruments. The configurations are created by the instrument scientists through S.E.C.I. The configuration file principally determines which nodes are available in the tree-view, which programmes populate these nodes and which – if any – experimental values are listed in the block list.

**USING S.E.C.I**

**ACCOUNTS**

The File menu is used for adding or removing user accounts and for logging in or out. To log in you must have an S.E.C.I account and know the relevant password. There are three types of account (in order of power): Administrator, Instrument Scientist and User. Of these, the user and instrument scientist accounts are the most used.
The Administrator accounts have the following privileges:

- Create Administrator, Instrument Scientist and User accounts.
- Remove instrument scientist and user accounts.
- Overwrite or delete configurations saved by Administrators, Inst Sci, Users.
- Open any saved configuration.
- Create new configurations.
- Edit configurations and save them under a different filename.
- Minimise S.E.C.I.

The Instrument Scientist accounts have the following privileges:

- Overwrite or delete configurations saved by Instrument Scientists and Users.
- Open any saved configuration.
- Create new configurations.
- Edit configurations and save them under a different filename.
- Minimise S.E.C.I.

The User accounts have the following privileges:

- Overwrite or delete configurations saved by other Users.
- Open any saved configuration.
- Create new configurations.
- Edit configurations and save them under a different filename.

To add an account, select ‘Add User’ from the File menu (Administrator only). In the dialog panel enter in the new account name and password, then select the type of account required and click ‘OK.’ The new account is now added to the account database. Note: this account will be valid for all instruments.

To remove an account, select ‘Remove User’ from the File menu (Administrator only). In the dialog panel select the group of the user and then the user’s name from the list. To delete the account click ‘OK.’
CONFIGURATIONS

As stated previously, configurations are used to configure S.E.C.I for different experimental set-ups. They determine which programmes S.E.C.I loads (Labview, OpenGENIE and so on), which initial values equipment take, and which nodes are available on the tree-view. Through S.E.C.I it is possible to open different configurations, modify existing configurations and create new configurations.

OPENING A CONFIGURATION

To open a configuration it is necessary to be logged in with a valid account. From the Configuration menu select ‘Open Configuration,’ this will open a dialog form which lists all the available configurations for the current instrument. From the list select the required configuration and click ‘OK,’ S.E.C.I will now shutdown and restart in the new configuration. This may take a minute or so.

ADDING A DISPLAY PAGE (A TREE-VIEW NODE)

To add a node to the tree-view, select ‘Display Pages’ from the Configuration menu then from the sub-menu select ‘Add Display Page.’ A ‘New Display Page’ dialog form will now be shown. The top list box shows the main nodes, the new page will be a sub-node of one of these nodes. From the list of nodes select the required node, next it is necessary to name the new sub-node. Finally, it is necessary to choose the page type, the options are:

- VI – this is short for Virtual Instrument, this means the display page will be used for displaying Labview panels.
- Web – the page will be used for displaying web-pages
- Other – the page will be used other kinds of programmes.

Next, click ‘OK,’ the new page should now appear as a sub-node of one of the main nodes. To make this change permanent the configuration will need to be saved.
REMOVING A DISPLAY PAGE

Firstly to remove a Display page it is necessary to remove any programmes (see section 0) or Labview panels (see sections 0 and 0) from the page first. Then select ‘Display Pages’ from the Configuration menu then from the sub-menu select ‘Remove Display Page.’ From the new window select the display page to remove then click ‘OK.’ The page should now be removed, to make this removal permanent it is necessary to save the configuration.

RENAMING A DISPLAY PAGE

To rename an existing Display page select ‘Display Pages’ from the Configuration menu then from the sub-menu select ‘Rename Display Page.’ From the new window select the Display page to rename and then enter a new name, to finish click ‘OK.’ The Display name will now have been changed, to make this change permanent the configuration must be saved.

ADDING A LABVIEW PANEL TO AN EXISTING CONFIGURATION

To add a Labview panel to a configuration, it is necessary to have a node on the tree-view for Labview panels, to do this see section 0.

To add a Labview panel select ‘Labview Panels’ from the Configuration menu and from the sub-menu select ‘Add Labview Panel.’ A new ‘Add Labview’ dialog panel will open from which the display page for the new Labview panel can be selected. When a display page is chosen a File dialog box will open, from this select the desired Labview VI file and click ‘Open.’ The location of the new VI file will now be listed in the ‘Add Labview’ dialog panel, click ‘Add’ to add the new Labview panel. A new dialog panel will open; from this dialog panel it is possible to configure the behaviour of the Labview panel. The first option is whether to add any associated INI files to the Labview panel. The INI files contain data for initialising and configuring the Labview panels. The two other options available for the new Labview panel are whether to start the panel running upon loading or to hide the panel. The configuration will need to be saved to make this change permanent.
REMOVING A LABVIEW PANEL FROM EXISTING CONFIGURATIONS

To remove a Labview select ‘Labview Panels’ from the Configuration menu and from the sub-menu select ‘Remove Labview Panel.’ A dialog panel will open; from this panel select the Display page from which the Labview panel will be removed and then select the VI to remove. Click ‘OK’ and the panel is removed from this instance of the configuration. The configuration will need to be saved to make this change permanent.

CHANGING A LABVIEW PANEL’S ASSOCIATED FILES

From the Configuration menu select ‘Labview Panels’ and then select ‘Change Associated files’ from the sub-menu. A new dialog window will open, from this select the Display page of the Labview panel to be edited and then select the actual VI. It is now possible to add or delete the associated INI file for the panel. To make any changes permanent the configuration will need to be saved.

MOVING A LABVIEW PANEL TO A DIFFERENT DISPLAY PAGE

First it is necessary to select the Display page containing the Labview panel which is to be moved. Then from the Configuration menu select ‘Labview Panels’ and then select ‘Move Labview Panel to Another Page’ from the sub-menu. The new window will list the Labview panels available in the selected Display page, select the panel to move then choose which Display page to move it to. Click ‘OK’ and the Labview panel will now be shown on the chosen Display page. To make the change permanent the configuration will need to be saved.

EDITING THE START-UP ORDER OF THE LABVIEW PANELS

The behaviour of one Labview panel may depend on one or more other Labview panels, and subsequently the order in which the panels are loaded may be of significance. To set the start-up order of the panels select from the Configuration menu ‘Labview Panels’ and then choose ‘Set Properties for Panels’ from the sub-menu. A new window appears containing a chart of the Labview panels in the configuration. In this chart it is possible to set
the order in which the Labview panels are loaded. Each panel must have a unique value for the order. Any panels that have not been explicitly set an order number will be assigned an order number greater than 10,000 by S.E.C.I. It is also possible to set a wait time for each panel, this indicates how long after the previous panel has loaded should the panel wait before loading. Once any editing has been completed click ‘OK’ to finish. To make any changes permanent it is necessary to save the configuration.

SETTING THE VISIBILITY OF THE LABVIEW PANELS

It is possible to hide Labview panels when the user does not need to know about them. The visibility of all the panels can be edited or reviewed in one window. To do this, select from the Configuration menu ‘Labview Panels’ and then choose ‘Set Properties for Panels’ from the sub-menu. A new window will appear (the same as in section 0). The checkboxes in the ‘Visible?’ column show whether a panel is visible or not – checked for visible, unchecked for not. The visibility of a Labview panel can be set by clicking on the checkbox. When finished click ‘OK’ to close the window. The configuration will then have to be saved to make any changes permanent.

SETTING A LABVIEW PANEL TO RUN AUTOMATICALLY

Labview panels can be set to run automatically after loading or not when S.E.C.I. This property is set in the same window as discussed in sections 0 and 0. To open this window, select from the Configuration menu ‘Labview Panels’ and then choose ‘Set Properties for Panels’ from the sub-menu. In the new window there is a column called ‘Run at Start-up?’ If the checkbox is checked for a Labview panel then it will start running when it is loaded, if it is unchecked then it will load but will require the user to start it. By clicking the checkbox this setting can be changed from on (checked) to off (unchecked). Click ‘OK’ to keep the changes and close the window. To make these changes permanent the configuration will need to be saved.

ADDING NON-LABVIEW PROGRAMMES TO CONFIGURATIONS

To add non-Labview programmes to a configuration it is necessary to add a Display page for these programmes as shown in section 0. If this has been done then select ‘Other
Programmes’ from the Configuration menu, in the sub-menu select ‘Add Programme.’ In the new window select the Display page to add the new programme to this will open a file dialog window for selecting the new programme. Choose the programme to add then click ‘Open,’ this will close the file dialog window. Click ‘Add’ and the new programme will be added to the Display page. The configuration will need to be saved to make this change permanent.

REMOVING OTHER PROGRAMMES

To remove a non-Labview programme from a configuration select ‘Other programmes’ from the Configuration menu, in the sub-menu select ‘Remove Programme.’ In the new window select the Display page of the programme to be removed then select the actual programme. Click ‘OK’ to remove the programme. The configuration will then need to be saved to make this change permanent.

ADDING A WEB VIEWER TO A CONFIGURATION

To add a web viewer to a configuration it is necessary to add a Display page for web pages as discussed in section 0. Then select ‘Web Viewers’ from the Configuration menu, in the sub-menu choose ‘Add Web Viewer.’ In the new form select the Display page to add the viewer to and then type in the URL of the web-site to display. Finally, enter a title for the web viewer window and click ‘Add.’ The new web viewer should now appear. To add this web viewer permanently the configuration will need to be saved.

REMOVING A WEB VIEWER

To remove a web viewer, first select the Display page with the web viewer in. Then select ‘Web Viewers’ from the Configuration menu, in the sub-menu choose ‘Remove Web Viewer.’ From the dialog box select the web viewer to remove and click ‘OK.’ To remove this viewer permanently the configuration will need to be saved.
SAVING, VIEWING AND DELETING CONFIGURATIONS

The options to save, view and delete configurations are all grouped together under the ‘Save/Delete/View Configurations’ option on the Configuration menu. Choosing this will open a new window offering the choices for saving, viewing and deleting configurations. There are three different options for saving a configuration, these are:

- **Save Current Config** – this will save the current configuration without changing the configuration name (i.e. it will overwrite the configuration). This is permission based, for example: a User use ‘Save Current Config’ is the current configuration was created or saved by an Instrument Scientist.

- **Save Current Config As** – this will enable the current operator to save the current configuration under a different or new name. Again this is permission based: a User would be able to save a configuration under a new name, but may not be able to save over an existing configuration.

- **Save As Other User** – this allows an Instrument Scientist or Administrator to save the current configuration as a lower permissions group. For example: an Instrument Scientist could save a configuration as a User, thus the User will be able to overwrite the configuration.

To use ‘Save Current Config,’ click that button; the configuration will then be saved depending on the permissions. To use ‘Save Current Config As,’ click that button, the window will then change. In the changed window either enter in a new configuration name or select an existing one, then click ‘OK.’ The configuration will then by saved if the permissions are correct. To use ‘Save As Other User,’ click that button, the window will then change. In the changed window either enter in a new configuration name or select an existing one. Then select the permission group and username with which the configuration is to be saved. Finally, click ‘OK’ and the configuration will be saved provided the permissions are right.

Viewing a configuration allows the operator to view the Labview panels in a chosen configuration. To do this click the ‘View A Config’ button, this will change the window. In the changed window select the configuration to be viewed, after a few seconds the list of Labview panels will be displayed. Click ‘OK’ to exit.
Deleting a configuration allows the operator to delete a chosen configuration. Clicking the ‘Delete A Config’ button changes the window form, then from the changed form select the configuration to be deleted and click ‘OK.’ The configuration will then be deleted provided the current operator has the correct permissions to delete the chosen configuration.

**ADDING ONE CONFIGURATION TO ANOTHER**

It is possible to add one configuration to the current configuration. To do this, from the Configuration menu select ‘Add Configuration’ this will open a window with a list of available configurations. From the list select a configuration and click ‘OK,’ the chosen configuration should now get added to the current configuration. The new combined configuration will have to be saved for the changes to be permanent.

**CLOSING THE CONFIGURATION**

Selecting ‘Close Configuration’ from the Configuration menu will cause the current configuration to be closed and the current operator to be logged out.

**S.E.C.I OPTIONS**

**ADDING OR EDITING CUSTOM BLOCKS AND LOG VALUES**

S.E.C.I allows the operator to customise the dashboard so that it can monitor experiment values (known as blocks) which are not included in the main status panel. These blocks are added via the ‘Monitor and Log Values’ option on the Options menu. Selecting this option opens a new window form which contains a grid containing the current blocks. Select an existing block and click ‘Change’ to edit it or click ‘Add’ to create a new block, both methods will cause a new window form to appear. This new form allows the block to be configured, it is recommended that when configuring a new block to start from the top-left and work down to the bottom right. This guide will provide a walkthrough for creating a new block starting from the top-left:
1. Choose a Display page from the available Labview Display pages; this will create a list of the panels (VIs) available.

2. From the list of panels choose the panel which contains the value to be monitored. Once a panel has been chosen, the three lists on the next row down will be populated.

3. The first list (working from left to right) contains all the values (and their type, i.e. Boolean, integer etc.) that can be monitored on the chosen panel. Highlight the required variable to continue.

4. (Optional) The second list allows a set variable to be assigned. This allows OpenGENIE to send new values for this variable to the Labview panel.

5. (Optional) If a set variable is assigned it may be necessary for OpenGENIE to push a Labview button to send the new value. The third list chooses which button to press.

6. A name for the block must be entered and the option to include is also available.

7. The next three parameters to set are the frequencies for logging the block values and for updating the blocks in the dashboards. This is done by setting the intervals, in seconds, which S.E.C.I will wait before logging the value or updating the dashboard. A value of zero will mean that the logging or updating will be disabled.

8. The next option is to decide whether to turn ‘Run Control’ on, by default it is off. Run control determines a range of values between which data is collected, for example: if there was a temperature block, it may be possible that only data for temperatures between 10°C and 20°C needs to be recorded.

9. There is an option to save the block value (toggle on or off), this is for when a block does not change during the experiment, rather than logging an unchanging value, the value of the block is saved once at the end of the run. (THIS CURRENTLY DOES NOT WORK AS S.E.C.I DOESN’T KNOW WHEN AN EXPERIMENT ENDS!)

10. The final option is to enable or disable the block. If the block is disabled it will no longer log or update the values. The dashboard will still show the block name but with disabled written next to it. When the block has been configured, click ‘OK’ to finish.
Blocks can also be deleted; to do this select the block in the grid and then click “Delete.” The order in which blocks appear on the dashboard can also be set by clicking “Change Order.” This will open a new window in which the all the blocks are listed. By selecting a block and clicking the “Up” or “Down” button the block’s position can be changed, as required. Click “OK” to accept the changes. To make any changes permanent it is necessary to save the configuration.

DASHBOARD PAGE OPTIONS

This section refers to the dashboard page node of the tree-view, not the S.E.C.I dashboard. To access the Dashboard page options, select ‘Dashboard Page Options’ from the Options menu. This will opened the Dashboard options window; from this window the following options are available:

- Add A Graph – this option sets up a graph plot to monitor a block value

- Change A Graph – allows the properties of an existing graph to be changed.

- Delete A Graph – this option will remove an existing graph from the Dashboard page.

- Show or hide the big dashboard – choose whether to show the big version of the S.E.C.I dashboard on the Dashboard page.

- Show or hide the OpenGENIE scripting window – choose whether to add the OpenGENIE scripting window to the Dashboard page

- Add A Block Display Box – this option will add a window box to the Dashboard page which contains the value(s) for a chosen block or blocks.

- Change A Block Display Box – this option allows the properties of an existing display box to be changed.

- Delete A Block Display Box – this option will remove an existing display box from the Dashboard page.
When ‘Add A Graph’ is selected a new window opens, from this window select the block to be plotted. Next, choose whether to plot the set point then enter a label for the Y-axis and a name for the graph. Finally, choose whether to show another block on the same graph and whether to increase or decrease the graph buffer size (the number of points stored). Click ‘OK’ to add the graph. Choosing ‘Change A Graph’ will open a new window, in this window all the values set for the graph when adding the graph can be changed. Click ‘OK’ to accept the changes. Selecting ‘Delete A Graph’ will open a window listing the existing graphs. Select the graph to delete and click ‘OK.’ The graph will now be deleted.

When ‘Add A Block Display Box’ is selected a new window opens, first add a name for the new display box and then choose which blocks to add to the box. To select a block to add, choose the block from the list then click ‘Add Selected Block Now.’ If a wrong block is added it can be removed by selecting it in the ‘Blocks To Be Displayed’ list and click ‘Remove Selected Block.’ When all the required blocks have been added click ‘OK’ to create the display box. Choosing ‘Change A Block Display Box’ will open a new window. In this window select the display box to be added, then blocks can be added or removed from this box. Click ‘OK’ when finished to accept the changes. Selecting ‘Delete A Block Display Box’ will open a new window. In the list of display boxes chose the box to be deleted and click ‘OK’ to delete it.

For all the options in the ‘Dashboard Page Options’ it is necessary to save the configuration afterwards to make the changes permanent.

LOGGING DISPLAY VALUES

It is possible to log the values listed in the main status panel. To do this, select ‘Log Display Values’ from the options menu. A new dialog window will appear, in this window select the value to log and click ‘Add.’ This can be repeated for as many values as required. Click ‘OK’ when finished. The values will now be logged every 10 seconds in C:\data\InstName_RunNum_ValueName.txt.

WEB/WAP DASHBOARD OPTIONS

The status of an experiment being run by S.E.C.I can be viewed on the web, either through a standard internet browser or a WAP equipped mobile phone can be used. However,
there may be occasions when an experiment is of a sensitive nature and the user wants to limit the web access. There are two web options that can be enable or disabled on S.E.C.I:

- Display web dashboard (by default this is enabled). This option sets whether the web dashboard will show any information on the web/WAP page.

- Show title (by default this is disabled). This sets whether the title is shown on the web/WAP page. Thus it is possible to display the experiment status (which anyone can see) for remote viewing but not the title which may contain sensitive information.

These options can be set under ‘Web/WAP Dashboard Options’ in the ‘Options’ menu by checking the choices on the sub-menu. These settings are stored in the S.E.C.I.ini file.

S.E.C.I.INI SETTINGS

There are number of options in S.E.C.I that can only be configured using the S.E.C.I.ini file. These options are:

- last_user_config – this keeps a record of the last configuration used/set before S.E.C.I was closed. S.E.C.I will automatically load this configuration on start-up. If a configuration causes S.E.C.I to crash on starting then a different configuration can be set here.

- username_file – this sets which user file is used to check passwords against. This should never need to be changed.

- last_run_number – this records the last run number before S.E.C.I was closed. This should never need to be changed.

- status_colours – this determines whether the status colours on the S.E.C.I dashboard are activated. It must be set to true or false.

- last_user – this keeps a record of who was logged in when S.E.C.I was closed. S.E.C.I will start with this user logged in.

59
• UseNewDAE – some instruments are using a newer version of the DAE software, this Boolean determines whether this is the case.

• RunningICP – this Boolean determines whether ICP is being run.

• IsMuons – this Boolean is used to set whether the experiment is a Muon experiment. If this is true then the monitor values are not shown on the S.E.C.I dashboard.

*These options should only be changed if you are certain you know what you are doing.*

S.E.C.I EXAMPLES

CREATING A SIMPLE CONFIGURATION

In this example a simple dummy configuration will be created. Starting from a blank configuration (no extra pages or Labview panels):

1. Select Configurations->Display Pages->Add Display Page. In the new window:

   • Select Instrument as the Page Group.
   • Type in ‘Eurotherm Page’ as the Display Name to Create.
   • Choose ‘VI’ as the page type.
   • Click ‘OK.’

2. Select Configurations->Labview Panels->Add Labview Panel. In the new window do the following:

   • Choose ‘Eurotherm Page’ as the display page.
   • In the file dialog window navigate to ‘Muon Eurotherm Front Panel,’ in this directory select ‘Eurotherm Front Panel.vi’ and click ‘Open.’
Click ‘Add’ and a new window opens. Select ‘Run VI When Loaded’ and click ‘OK.’ The Labview panel should now appear.

3. Repeat 1 but call the new page ‘ITC Page.’

4. Repeat 2 but for the ‘ITC Page and navigate to the ‘SOLOITCFRONT PANEL’ directory in the ‘Oxford Software’ directory and choose ‘SoloITC503 – 2.vi.’ Again, select ‘Run VI When Loaded.’

5. For this example it is necessary that the SoloITC503 – 2.vi always loads first. Select Configuration->Labview Panels->Set Panels Startup Order. A new window will appear with the two VIs listed, change the order for the SoloITC503 – 2.vi from 10001 to 1 and click ‘OK.’

6. It is decided that it would be useful to display the Sample temperature from the Eurotherm panel on the S.E.C.I dashboard. It is also required that the values are logged in a text file. From the Options menu select ‘Monitor and Log Values’ a new window will open. Click the ‘Add’ button and do the following (starting from the top-left):

   • Choose ‘Eurotherm Page’ from the list of display pages then select the VI.
   
   • Select ‘Sample Temperature (Numeric)’ from the ‘Value to Read’ list.

   • Ignore the optional parameters and enter ‘Sample_Temp’ as the name and K as the units

   • Leave the remaining settings as their default values and click ‘OK,’ then click ‘OK’ again to close the final window. The Sample Temperature should now be displayed in the dashboard and be logged in c:\data\.

7. It is now decided that plotting a graph of the Samp_Temp on the Dashboard page would be useful, to do this:

   • Select Option->Dashboard Page Options.
• In the new window, click ‘Add A Graph.’
• Choose the Sample_Temp block and enter ‘Temperature’ for the Y-axis name and Sample_Temp for the graph name. Then click OK. The graph should now appear on the Dashboard page of the tree-view.

A simple configuration has now been created and this can be saved. Warning: do not use this configuration on an instrument as it is only an example.
APPENDIX IX - COMMAND LINE SCRIPTING

Scripting on the PC is done via an Open GENIE window. The command style is very similar to the VMS operating system i.e:

COMMAND/QUALIFIER value1 value2 keyword1=value3 keyword2=value4

For example:

CHANGE title="new title" user="new user"
CSET/WAIT temp1=4.0

There are a few important differences from VMS however. Character strings must always be included in "" quotation marks – this is to distinguish them from words or functions that form part of the GENIE language and so make interpreting the language easier to program. For example, on VMS you could type:

CHANGE title something ! Works on old VMS system only

This was possible because a separate program interpreted each command – with the GENIE processor we need to tell it that title and something are not variable names. Being more explicit in this way allows more complicated expressions to be written in the language. For example in GENIE you can change both the title and user in one command as shown above.

In moving commands from VMS to the PC, commands will usually become of the form name=value. A list of PC commands and their VMS alternative are tabulated below:
<table>
<thead>
<tr>
<th>PC Command (syntax / example)</th>
<th>Equivalent VMS Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHANGE title=String</td>
<td>CHANGE title something</td>
<td>Change the current run title</td>
</tr>
<tr>
<td>CHANGE title=&quot;new title&quot;</td>
<td>CHANGE title &quot;new title&quot;</td>
<td></td>
</tr>
<tr>
<td>CHANGE user=String</td>
<td></td>
<td>Changes the current user(s)</td>
</tr>
<tr>
<td>CHANGE user=&quot;new user&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHANGE rbno=Integer</td>
<td>CHANGE period 2</td>
<td>Changes experiment RB number</td>
</tr>
<tr>
<td>CHANGE rbno=1236</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UPDATESTORE</td>
<td>UPDATE followed by STORE</td>
<td>Created a SAV file which is copied to the analysis PC</td>
</tr>
<tr>
<td>CHANGE period=Integer</td>
<td>CHANGE period=2</td>
<td></td>
</tr>
<tr>
<td>CHANGE period=2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WAITFOR uamps=Real</td>
<td>WAITFOR 5.3 uamps</td>
<td>Sets number of uamps to wait for</td>
</tr>
<tr>
<td>WAITFOR uamps=5.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WAITFOR frames=Integer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WAITFOR frames=4000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WAITFOR seconds=Integer</td>
<td>WAIT 00:00:10</td>
<td>PC control waits for N seconds before continuing</td>
</tr>
<tr>
<td>WAITFOR seconds=10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>END</td>
<td>END</td>
<td>Creates RAW files and copies it to analysis PC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>PAUSE</td>
<td>PAUSE</td>
<td></td>
</tr>
<tr>
<td>RESUME</td>
<td>RESUME</td>
<td></td>
</tr>
<tr>
<td>ABORT</td>
<td>ABORT</td>
<td></td>
</tr>
<tr>
<td>CSHOW block_name</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CSHOW temp1</td>
<td></td>
</tr>
<tr>
<td>CSET block=value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSET temp1=5.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSET/CONTROL block=value lownlimit=low</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CSET/CONTROL temp1=5.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>lownlimit=4.8 hignlimit=5.2</td>
<td></td>
</tr>
</tbody>
</table>

Command files or control scripts can be run from an Open GENIE window on the instrument computer. A script is basically a compiled Open GENIE procedure, which is executed in the window. A procedure can be loaded in one of two ways depending on how it is written.

(1) You can write a standard PROCEDURE … ENDPORCEDURE program … in which case you use the LOAD or INCLUDE command

(2) You write a section of one line commands, in which you use the loadscript command. The LOADSCRIPT command will take the command, wrap them in a PROCEDURE … ENDPORCEDURE with the procedure name the same as the filename passed to LOADSCRIPT
Whichever you use, you will get a command which you can type to begin running the file. Procedure commands include all standard open genie commands with the following additions:

BEGIN # start data collection
END # stop data collection
PAUSE
RESUME
UPDATESTORE  # create a SAV file from the DAE
CHANGE title=String  # e.g. CHANGE title="new title"
CHANGE user=String  # e.g. CHANGE user="new user"
CHANGE period=Integer  # e.g. CHANGE period=3
CHANGE rbno=Integer  # e.g. CHANGE rbno=12345
WAITFOR frames=Integer
WAITFOR unames=Real
WAITFOR seconds=Ineger
WAITFOR time=

PUSHLABVIEWBUTTON “vi name” “button name”  # push this button on a VI
PUSHLABVIEWBUTTON/WAIT “vi name” “button name”  # push this button on a VI and wait for it to pop back up
Value=GETLABVIEWVAR(“vi name”,“variable name”)
SETLABVIEWVAR “vi name” “variable name” value
CSHOW/ALL
CSHOW block
CSET block=value lowlimit=value range:low:high highlimit=value
CSET/WAIT block=value  # wait for in range
CSET/CONTROL block
CSET/DISPLAY block
GETRUNSTATE()  # function to return run state e.g. “SETUP”
WAITFORBOOLEAN/TRUE “vi name” “Boolean variable name”
WAITFORBOOLEAN/FALSE “vi name” “Boolean variable name”
WAITFORBUTTON “vi name” “button name”  # wait for button to pop up

Note: do not create a variable with the same name as a CAMAC block
COMMAND FILE EXAMPLES:

Example 1

cset/control temp1=300.0 lowlimit=295.0 highlimit=305.0
cset/wait temp1=300.0 lowlimit=295.0 highlimit=305.0
cset wccr -150.0
change title="thiourea parabanic acid 300 K wccr=-150 Tilt OR2 j:15,10"
begin
  sleep 60
  waitfor uamps=30.0
  updatestore
  waitfor uamps=200.0
end
#

Example 2

PROCEDURE SXD_SUB
PARAMETERS ccr_val t1
LOCAL tmp
setlabviewvar "sxd ccr - front panel.vi" "Target" ccr_val
pushlabviewbutton "sxd ccr - front panel.vi" "Move"
LOOP
  tmp = getlabviewvar("sxd ccr - front panel.vi", "Ready")
  EXITIF tmp = 1
  printin "waiting for ccr"
  SLEEP 5
ENDLOOP
cset temp1=t1
LOOP
  tmp = getlabviewvar("eurotherm controller - details.vi", "Temperature - 0")
  EXITIF (abs(t1 - tmp) <= 20)
  printin "waiting for eurotherm"
  SLEEP 5
ENDLOOP
PROCEDURE SXD_SCAN
  sxd_sub -155.0 300.0
  begin
  waitfor uamps=60.0
  end
  sxd_sub -120.0 300.0
  begin
  waitfor uamps=60.0
  end
  printin "Finished"
ENDPROCEDURE
#